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Preface
The material in this book gives you the opportunity to understand Key Skills and practise them so you are able to 
meet the high standards set out in the Level 1 Key Skills Standards for:

  Communication;

  Application of Number; and

  Information and Communication Technology.

The introductory section of this book explains each of the Key Skills and how to gain a qualification.

The book is then divided into three separate chapters covering the three Key Skills mentioned above.

Each chapter is further divided into three distinct parts:

1 Reference Sheets
These sections provide all the necessary background information to prepare you for each of the Key Skills. They 
provide useful exercises that will: 

  aid your learning;

  can be used for revision; and

  prepare and aid you for the Part A Tasks and End of Assessment questions.

2 Part A Tasks
Working through these will help you produce work at the right level and prepare you for the End Assessment.

As you complete each task you will become more confident about what is expected in Key Skills and be able to use 
your knowledge and understanding to pass the End Assessment and put together a Portfolio of Evidence.

3 End Assessment questions
These sections provide examples of the type of questions that are likely to appear on an End Assessment paper and 
that you may have to pass as part of your Key Skills qualification. 

Further resources
When your tutor thinks you have enough knowledge of Key Skills, she/he will give you an assignment, or 
assignments, to complete. Working successfully through the assignment(s) will show you are able to apply your 
knowledge and understanding, and produce work that will go into your Key Skills Portfolio of Evidence. These 
assignments are contained in the Tutors’ book.

Additional resources and information can be found at www.lexden-publishing.co.uk/keyskills.

Software
The software used throughout this publication is Microsoft Office 2003® and Internet Explorer 6® running on 
Microsoft Windows XP®.
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Introduction

Mandatory Key Skills

Communication 
Application of Number 

ICT

Put together a 
Portfolio of Evidence

Usually an assignment written for 
you by your tutor to cover the Key 
Skill, or a number of Key Skills in 
one piece of work.

The Portfolio is based on Part B of 
the Key Skill Standards.

Pass a test ‒ 
called an End Assessment

This test is 40 multiple-choice 
questions and, at Levels 1 and 2, 
you have either 1 hour or 1 hour 15 
minutes to complete it depending on 
the Key Skill.

The questions are based on Part A of 
the Key Skill Standards.

Good News!

If you already have some GCSE or ICT 
qualifications, it may not be necessary 
for you to take the End Assessment! Your 
tutor will help you with this ‒ it is called  
PROXY QUALIFICATIONS.

Practise Part A Key 
Skills tasks in this book 
to help you:

Wider Key Skills

 

 
Opportunities to work towards achieving the Wider Key Skills are provided in the Portfolio assignment work and are 
included in the Tutors’ book that accompanies this text.

HOW TO GAIN A KEY SKILLS QUALIFICATION

Improving Own Learning and Performance 
Problem Solving 
Working with Others

Put together a Portfolio of Evidence

Usually included in an assignment written for you by 
your tutor to cover the Key Skills or Communication, 
ICT or Application of Number.

The Portfolio is based on Part B of the Key Skill 
Standards.

Practise Part A Key Skills 
tasks in your vocational 
studies to help you:
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1A personal letter written to a company
The following is an example of a personal letter written to a company:

6 Telford Drive 

Hightown 
Wiltshire 
HT4 7VV

Telephone: 01652
 974356 

Email: trevor@communication.co.uk

12 April 2005

The Secretary 

Hightown Drama Society 

The Strand Theat
re 

Hightown 
Wiltshire 
HT2 3GG

Dear Sir or Madam

I wish to enquire if y
our Society has an

y vacancies for so
meone who is 

a keen amateur dramatist?

In June I will be completing a two-year drama course at Hightown 

Community College and
, before I start University in October, I would 

be keen to gain e
xperience in a the

atre. This last year
 at College I have

 

particularly enjoy
ed working behind the

 scenes and would appreciate 

any experience o
f this type, if avail

able.

I look forward to perhaps he
aring from you in due cours

e and thank 

you for considerin
g my request.

Yours faithfully

Trevor Moore

Always begin 
with the date 
(dd/mm/yyyy).

Leave yourself 
space for a 
signature.

Writer’s home address, or return address. Don’t 
put your name here.

The address and telephone 
number/email address can 
be:

 in the centre;
 at the right hand side;
 at the left hand side; or
 a combination as seen 
in this example.

The letter is addressed to someone’s title because the name of the recipient is unknown. 
In this way the salutation is Dear Sir or Madam 
The complimentary close is Yours faithfully

Note: It is usual for a female to write her title: Mrs Tina Moore or Tina Moore (Mrs) 
A MAN NEVER CALLS HIMSELF MR. So if you receive a letter from ‘T Moore’, you can assume it is from a man!
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1WRITING AND SETTING OUT MEMOS

A memorandum ‒ plural memoranda
(abbreviated to memo)
A memo is an internal method of communication.

Memos must be short documents, and usually deal with one subject. A long document within an organisation is 
usually sent in the form of a report.

The memo should be signed by the sender.

M E M O R A N D U M

To  Mrs A Winston, Personnel Manager

From  T Gilbert, Central Records Manager

Date  15 June 2006

Subject  Lost file

Copies to Mr J Brown, Personnel Director 

  Miss P Patty, Central Records Clerk

 
Last week I informed you that Mrs Jane McAleer’s file had been lost or 

mislaid.

I am pleased to report that this has now been found and I have written 

to Mrs McAleer apologising for the delay in confirming the details she 

requested.

I am sorry for the inconvenience this has caused all parties.

Trevor Gilbert

 
Trevor Gilbert

This section  indicates 
who else, other than the 
named recipient, has 
received a copy.

The subject of the 
memo has been 
identified.

Although organisations have their own style of layout for memos, 
all memos contain these essential headings.

 
Typical layout of a memorandum (memo). This is formal as it includes people’s titles (Mr, Mrs, Personnel 
Manager, etc).

In this example you will see the message is short and simple and deals with only one point.

Who the memo is from, and to whom it is being sent, are identified and the document is dated and signed.
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TASK 16: STOP SMOKING

Student Information
In this task, you will read 
information and use relevant 
parts of the information to 
design a poster to include 
relevant image(s).
You will then work with a 
partner to discuss your own 
and the other person’s posters. 
You will write a summary of 
your discussion. Ask your tutor 
for a blank copy of Appendix 3 
Pro Forma.

REMEMBER: 
When using a image make sure it helps the reader to better 
understand the topic. Use an image to enhance and explain. See 
pages 8 ‒9 on Using images in communication.
The information you include must be accurate.
Study the sheets carefully to make sure you complete all the 
important parts.
Spelling, grammar and punctuation are important.

Designing a poster and discussing it with a partner
Scenario
Your educational establishment is keen to promote STOP SMOKING to its students. The organisation 
already has a NO SMOKING INSIDE policy.
You have to design a poster on your own, then discuss it with a partner. 

Activities
1 Using the information in Appendices 1 and 2 design an A4-sized poster aimed at discouraging 

teenage smoking.
 The Principal will look at all the posters produced and the one he thinks is the most successful 

in communicating the message, will be reproduced and displayed on notice boards around the 
building.

 Make use of the information you have been given, and show you have understood the content 
of the graphs by including some of their information.

 You should use appropriate images to help the reader understand some of the points you 
make.

2 When you have completed your poster, ask your tutor to select a partner with whom you can 
work. 

 With this partner you are going to discuss both posters and make recommendations for how to 
improve each of them.

 Discussing your poster. You must tell your partner about your poster, i.e. why you included 
the information you used ‒ why you thought it was relevant to the poster’s intention; why you 
displayed the information as you did;  why you chose the images it contains.

 Your partner will listen, probably ask questions, and then you will discuss how your design could 
be improved.

 After the discussion, make notes on the Appendix 3 Pro Forma.
 Discussing your partner’s poster. This time you will listen to your partner telling you about his/

her poster and you will be the one to ask questions and offer suggestions for improvement.
 Hand in your poster and the notes you made on the form in Appendix 3. 
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Appendix 2

Smoking by age 
(Prevalence of regular smoking by age)
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2Volume
The volume of objects is generally found by multiplying the length x width x depth and is shown by the 
symbol ³.

At Level 1 you are expected to work out simple volume in box shapes. All of the dimensions are given. 

Q  What is the volume of the following object?

Depth 
D  
3m

Length 
L 

4m

Width 
W 
3m

  The volume is found by L x W x D. Replace the letters with the numbers and this is 4 x 3 x 3 = 36m³.

Using formula
At Level 1 you will not be given specific formula to do. However, you will use formula to find the area and 
volume in simple objects.

Formula is something as simple as finding area, L x W where L is length multiplied by W width. It can also be in 
the volume of a cube, L x W x D. It is also used in finding the area of a circle by πr² or in the volume of a cylinder, 
πr²d, but these are expected  at Level 2. 

Whatever formula is given for you to use, it is simply a case of replacing letters or symbols with numerical 
values. 

DATA
At Level 1 you will be expected to work with up to ten sets of data displayed in various forms. You will need to 
understand, read, write, order, and compare data in tables, charts, diagrams and graphs.

Data can be displayed in not only numerical form, i.e. numbers, but also in various graphical modes. In other 
words, displayed in images, tables, charts, diagrams and graphs. This makes it possible to show comparisons, 
trends or even patterns in data.
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2Tables
A table is an easy way to record and display data. For instance, you have recorded the colour of cars in the 
college car park. There is a suitable title and column headings for colour and number of cars recorded. You may 
also place a total at the bottom to show how many cars there were in the car park.

Cars in the College
Colour Number
Silver 12
Blue 8
White 5
Black 10
Red 7

Tables can also display a vast amount of information and this may seem confusing at first. 

Here is an example of a typical bank repayment table. So if you were interested in borrowing say £1,000 to buy a 
car, you can compare figures for 12 months, 24 months, 36 months, 48 months or 60 months.

Bank Repayment Period
Amount of Loan £s 12 Months 24 Months 36 Months 48 Months 60 Months

£10,000 £916.67 £504.17 £369.72 £305.02 £268.42

£7,000 £641.67 £352.92 £258.81 £213.51 £187.89

£6,500 £595.83 £327.71 £240.32 £198.26 £174.47

£6,000 £550.00 £302.50 £221.83 £183.01 £161.05

£5,500 £504.17 £277.29 £203.35 £167.76 £147.63

£5,000 £458.33 £252.08 £184.86 £152.51 £134.21
£4,500 £412.50 £226.88 £166.38 £137.26 £120.79
£4,000 £366.67 £201.67 £147.89 £122.01 £107.37
£3,500 £320.83 £176.46 £129.40 £106.76 £93.95
£3,000 £275.00 £151.25 £110.92 £91.51 £80.53
£2,500 £229.17 £126.04 £92.43 £76.26 £67.10
£2,000 £183.33 £100.83 £73.94 £61.00 £53.68
£1,500 £137.50 £75.63 £55.46 £45.75 £40.26
£1,000 £91.67 £50.42 £36.97 £30.50 £26.84

Amount borrowed against 
repayment period
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2Charts
Charts are very appealing in appearance and can make viewing data easy, especially when comparing or 
contrasting. Rather than just showing numbers, they can be in the form of a pie chart or a bar chart, etc. 
Generally at Level 1 the charts used tend to be either pie charts or bar (vertical, horizontal) charts.

Pie charts
Here is an example of a pie chart showing the ages of people attending a sports club. There is an appropriate 
title and labels for the segments:

65 + yrs 41 ‒ 64 yrs

21 ‒ 40 yrs

Under 21 yrs

Sports Club

Suitable 
labels

Title

It can be clearly seen that the most popular age group is the 21 ‒ 40 year olds.

The least popular group is the 65 years and over.

It is also easy to compare the age groups as a whole or individually.

However, the age groups can also have a numerical value applied of: figures or percentages and even degrees 
displayed alongside the groups. 

This adds more detail to the chart.

Bar charts
Bar charts can display single sets of data and also two or more sets of data. This is useful when comparing 
information. However, this is good as long as there are not too many bars displayed, as this can be confusing.

Bar charts tend to be displayed either vertically or horizontally. A title is generally included and axes displayed 
with suitable scales or labels.
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2TASK 4: HALF BAKED

Student Information
In this task you will be 
calculating volume, area, the 
profit ratio of customers, and 
reading scales. 

REMEMBER: 
Break the task down into small manageable parts.
Clearly show all methods of working out.
Show you are checking your calculations for accuracy.

Volume, weight, check calculations and profit
Scenario
Today you are working in a bistro named Half Baked. It is situated in the centre of town and is very popular. 
You are employed as a chef and occasionally help serve customers.

Activities
1 The ingredients for baking scones are shown here:

Ingredients for 8 scones

200ml full fat milk 150g sultanas

250g self raising flour 40g butter

 Show a method that will calculate how much butter is required to make 64 scones.

2 Cream teas are served at a cost of £2.50 in the bistro and during the afternoon sixty are sold 
making a profit of £150. 

 Show a check calculation that would make sure the profit is correct.

3 During one busy weekend the customers using the bistro were in the ratio of 3 : 7 males to 
females. If a total of 200 people came in, calculate how many males to females there would be. 

 Clearly show your method of working out.

4 The bistro makes a turnover of £12,672 one week. Write this figure in words. 

5 Bread is baked in cooking tins. Calculate the volume of the following bread baking tin in 
centimetres cubed.

15cm

15cm
20cm
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26 Flour is weighed to make bread. Look at the following set of kitchen scales and accurately read the 
scale to the nearest 1/4 pound. 

7 New carpet is required for the bistro. Look at the following diagram of the bistro.

 Calculate the total area in metres².

20m

10m

Exit

Half Baked Bistro 2m

5m

8 If new carpet costs £22.50 per m²; work out the cost of the new carpet for the bistro.

9 A new piece of carpet is also required at the exit stairs of the bistro. 

 Look at the diagram of a side view of the stairs.

Exit 
Stairs

4m

20cm
30cm

 The exit stairs are 2 metres wide.   Calculate the area of the stairs. 

10 Calculate the additional cost of carpet for the exit stairs.

11 Form a total cost of carpet for the bistro and the area in metres squared covered.
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3 USING THE INTERNET AND EXPLORING THE WORLD 
WIDE WEB

What is the Internet?
The word Internet is abbreviated from internetwork, which literally means a network of interconnected 
networks. It allows computers to communicate with each other and exchange information. By using your 
computer to access the Internet you are able to view information from the huge global “library” of electronic 
information known as the World Wide Web (www) and communicate with others, for example by sending and 
receiving email.

Using the World Wide Web
This huge global library is made up of millions of websites that are, in turn, made up of web pages. A website 
might contain just one page or millions of pages. To move around a website you use hyperlinks. Hyperlinks are 
used on text (usually identified in a different colour to the text) and on pictures (graphics).

The easiest way to identify a hyperlink is to look at your mouse pointer. As you place it over a hyperlink it 
changes to a hand like this:

All websites have a Uniform Resource Locator (URL), which is often referred to as a web address. URLs are used 
in hyperlinks to link pages and other websites together and can be used in the browser address bar to access a 
website directly. It is very important, when using a URL to access a website, to type it in correctly otherwise you 
will not find the correct website. Think of it like a telephone number if you dial the wrong number you either 
speak to the wrong person or don’t get through at all! 

To view web pages and “surf” the Internet you need to use a web browser, for example Internet Explorer, 
Netscape or FireFox. In our examples we will use Internet Explorer.

Accessing a web page using its web address
To access the Internet using Microsoft’s Internet Explorer:

 Double-click the icon which can be found on the desktop or select it from the Start 
menu and then All Programs.

The first page you will see is known as the Homepage. This is set in the browser and can be 
changed to a more useful website if necessary. Typically the homepage might be the school or college’s website 
or intranet site, or your favourite search engine site such as Google.

To go to another website:

 Click in the address box. This should highlight the current URL and you can type the new URL directly 
into the address bar. If it doesn’t highlight the current URL then use the delete or backspace keys to 
delete it.

 Type in www.lexden-publishing.co.uk/keyskills.

 Click the Go button (or press the Enter key) to visit our website.

 Move your mouse around the page to find the hyperlinks.

Tip
You don’t need to type 
in http:// as the browser 
will do this for you.
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3 Saving your work
Save
If you intend to keep your work then you need to save it. Do this often as you work to reduce the risk of losing 
your work. When saving your work for the first time:

 Select the File menu.

 Select the select the Save menu item to display the Save As window.

 Give your document an appropriate filename and choose a folder or drive to save your file to, e.g. a 
floppy disk or network drive.

Type an appropriate 
filename for your 
document here.

Click the down 
arrow to change 
the location of 
where you save 
your file here.

When you have 
selected the 
location and 
chosen a name for 
your document 
click Save.

Create a new 
directory by 
clicking here.

When you save your work again simply select the File menu and Save again or click on the Save button   
on the Standard Toobar. 

The Save As window is not displayed in subsequent saves. 

Save As
You will often need to save different versions of your documents with new filenames. To do this:

 Select the File menu.

 Select the Save As menu item to display the Save As window.

 Give your document an appropriate filename and choose a folder or drive to save your file to, e.g. a 
floppy disk or network drive.

Fonts
Fonts are a complete collection of letters and symbols belonging to a typeface that can be displayed in any 
point size or weight (bold, italic, etc.). A typeface is the style and design of a font.

Font Size describes the size of the text and is also known as the Point Size. 

Choosing the right typeface for your task is important and you need to think about who your document is going 
to be read by. If you are writing a letter for a job, it wouldn’t be advisable to use Comic Sans or a Script. You 
might, however, chose a more formal typeface such as Times New Roman or possibly Arial. Try not to mix too 
many typefaces in your document.
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3Text alignment
There are four types of alignment:

 Align Left  ‒ this aligns text so that it is straight on the 
left-hand side and ragged on the right.

 Center ‒ this centres text across the column. Both sides 
of the text are ragged.

 Align Right ‒ this aligns text so that it is straight on the 
right-hand side and ragged on the left.

 Justify ‒ this is when all of the text is completely straight on both 
sides of the column.

Note
The cursor must be placed 
in the text you want to 
change (or highlighted 
if there is more than one 
paragraph to change) 
before making one of these 
selections. 

Indenting text
Paragraphs can be indented to make them 
stand out from other paragraphs. To do this:

 Place the cursor in the paragraph to be 
changed (or highlight the text if there 
is more than one to be changed).

 Select the Format menu and then the 
Paragraph... menu item.

 In the  Paragraph window under 
Indentation, change the Left or Right 
setting to match your requirements.

Numbered and bullet lists
It is often useful to create numbered or bullet lists. For example:

1. Chocolate 

2. Sweets

3. Burgers

 Chocolate 

 Sweets

 Burgers

This is done by placing the cursor in the text you want to change and then selecting either:

 for a numbered list; or

 for a bullet list form the Standard Toolbar.

Change 
indentation 
here

Change line 
spacing here
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3SPREADSHEETS

What is a spreadsheet?
Spreadsheets are widely used in business and are mostly used for analysing figures such as accounts. By adding 
formulae to a spreadsheet’s cells, repetitive tasks can be made much easier. For example, if you were a wine 
merchant you could create a spreadsheet that worked out the cost of a case of wine based on the unit cost of 
the wine. If the price of the wine changed you would simply put in the new price and the spreadsheet would 
automatically work out the case price.

Microsoft Excel is the spreadsheet application used in this book.

Creating a new spreadsheet in Excel
When you first open Microsoft Excel, a blank Workbook is normally created by default.  A Workbook is the name 
given to an Excel document containing more than one spreadsheet (Worksheet). If a Workbook has not been 
created click on the New button.   

Task 
Pane

Formatting 
Toolbar

Title Bar 
This displays the name of the document. Unsaved Workbooks are called Book1, Book2, etc., 
depending how many new Workbooks you have created during that session.

Blank 
spreadsheet

Main 
Menu bar

Standard 
Toolbar

A Row

Formula Bar

A Column

Here cell B3 is 
highlighted

A spreadsheet is made up of columns and rows made up of boxes called 
cells. Each cell has an address ‒ like a grid reference on a map In the figure 
above cell B3 has been selected. You can identify the cell you are working in 
as it will have a black box around it. You can move around the spread sheet 
using navigation keys on the keyboard. Left Right

Down

Up Navigation 
keys



168

Inform
ation and Com

m
unication Technology:  Reference Sheets

3 Saving your work
Save
If you intend to keep your work then you need to save it. Do this often as you work to reduce the risk of losing 
your work. When saving your work for the first time:

 Select the File menu.

 Select the Save menu item to display the Save As window.

 Give your spreadsheet an appropriate filename and choose a folder or drive to save your file to, e.g. a 
floppy disk or network drive.

Type an appropriate 
filename for your 
spreadsheet here.

Click the down 
arrow to change 
the location of 
where you save 
your file here.

When you have 
selected the 
location and 
chosen a name for 
your spreadsheet 
click Save.

Create a new 
directory by 
clicking here.

When you save your work again simply select the File menu and Save again or click on the Save button   
on the Standard Toobar. 

The Save As window is not displayed in subsequent saves. 

Save As
You will often need to save different versions of your documents with new filenames. To do this:

 Select the File menu.

 Select the select the Save As menu item to display the Save As window.

 Give your spreadsheet an appropriate filename and choose a folder or drive to save your file to, e.g. a 
floppy disk or network drive.

Inserting and editing data
To add data to a spreadsheet:

 Click on the cell in which you want to add the data and start typing. You will notice that the text is also 
displayed in the  Formula Bar.

 When you have finished typing press the Enter key on the keyboard.
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3Excel assumes that you are entering a column of data and highlights the cell below ready for you to start typing.

To edit the data:

 double-click on the cell you want to edit. This will place the text cursor in the cell ready for you to start 
editing;

or

 click on the cell you want to edit and then edit the text displayed in the Formula Bar.

Formatting text
To change the Font and its attributes (size, weight, etc.):

 Highlight the cell or cells to be formatted and select one or more of the options available from the  
Formatting toolbar (see below).

Font (typeface)

Click on the down arrow to select a 
font from the drop-down list. Scroll 
down the list if necessary.

Font attributes

Click on one or more of these buttons to apply. the required 
style. Clicking the button again will remove the formatting.

Bold Italic Underline

Font Size (Point Size)

Click on the down arrow to select a font size from the drop-
down list. Scroll down the list if necessary. You can also type 
a size in if you want to if it’s not shown in the list.

Align 
Right

Align 
Left

Center

Formatting columns and rows

Changing column widths
The width of a column may be adjusted using one of the following methods:

 Double-clicking with the mouse between columns so that 
the text will fit exactly into the column.

Or

 Dragging with the mouse until the desired width is reached.

Or

 Highlight column by clicking on the column header (A, B, C, etc.).

 Select the Format menu and then the Width menu item.

 Enter the desired width in characters or cms, etc. in the Column Width 
window.

Position the pointer between 
the columns  and then 
double-click or drag the 
column to the size you require.
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3 Database creation
 Launch Microsoft Access.

 Click on the New button.  

 A Task Pane will appear on the right-hand side of the screen. Click on the Blank database... button.

 

 Select the location you want to save your database into.

 Access  automatically provides a filename of db1.mdb, (or db2.mdb, etc., depending how many 
databases have been started). Give your database a useful name that you will remember. In this case we 
will call it Personnel.

 Click on the Create button.

 Click on 
the new 
button.

1

Click on 
the Blank 
database... 
button.

2

Select the 
location to 
create your 
database in.

3

Choose a 
suitable 
filename.

4

The Task Pane

Click on 
Create.

5

 The Database window will now be displayed.
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3TASK 14: MUNCH BOX

Student Information
In this task, you will need to 
ask your tutor for the file called 
Munch Box.

REMEMBER: 
Read all instructions carefully.
Ensure that your work is saved so that it can be found easily.
Add your name and the date to the footer before printing.
Refer to pages 167 ‒ 176 and 178 for help with this task.

Formatting a spreadsheet
Scenario
You work in the Finance Department of Munch Box and today have to calculate customer accounts. In this 
task, you will open a spreadsheet, add formulae to calculate VAT and the Amount Due, as well as sorting 
the information.

Activities
1 Open the spreadsheet called Munch Box. Shown below is what you should have on your screen:

 

2 Sort the names in the Customer column to appear in ascending alphabetical order. You must 
keep the Order Values, etc., with the relevant customers, so remember to highlight all the cells 
beneath the column headings (A7 ‒ F12).

3 Insert a formula that will calculate the VAT at 17.5% for Harvey and Good and replicate the 
formula for the remaining VAT cells.

4 Insert a formula that will calculate the Order Total for each customer.

5 Insert a formula that will calculate the Amount Due for each customer (i.e. Order Total - Credit).

6 Add a custom footer to the spreadsheet that shows:

 Your name   The spreadsheet filename  Today’s date

7 Save the spreadsheet.

8 Print one copy of the spreadsheet making sure it fits on one page.

9 Print a second copy of the spreadsheet, showing the formulae. Make sure it fits on one page and 
all entries are visible.

10 Close the saved spreadsheet.
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3TASK 15: RADIANT

Student Information
You will be creating, sorting 
and querying a database.

REMEMBER: 
Read all instructions carefully.
Ensure your work is saved so that it can be easily found.
Refer to pages 189 ‒ 197 for help with this task.

Creating, sorting and querying a database
Scenario
You work in a fitness centre called Radiant, based in Howarth in West Yorkshire and today have been 
asked to update part of the database of members’ details and query it.

Activities
You are going to create the database shown in Appendix 1.

1 Launch Microsoft Access and create a new table in Design view.

2 Add the Field names and Data types as follows:

Title  Text

Surname  Text

Initials  Text

Address 1 Text

Address 2 Text

Membership Number Number

3 Save with the name Radiant.

4 Enter the information shown in Appendix 1.

5 Sort the Membership Number field into ascending numerical order.

6 Print the sorted database.

7 Add details of a new client as follows:

Miss Hardacre Y 8 Matlock Grove Bakewell 4457

8 Resort the Surname field into ascending numerical order.

9 Print the sorted database.

10 Close the database.

(Continued)
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3Activities (continued)
You are going to query the database to show only female members.

11 Open the database and select the Queries object in the database window.

12 Select Create Query in design view.

13 Select the Radiant table and click the Add button.

14 Close the Show Table menu.

15 Add all the fields to the query.

16 In the Criteria row for Title enter the criteria to return female members, i.e. Mrs or Miss or Ms.

17 Run the query.

18 Sort the Surname field into ascending alphabetical order.

19 Print the query.

20 Save the query as Female Members.

21 Close the database application.

Appendix 1

Title Surname Initial(s) Address 1 Address 2 Membership Number
Mrs Sidi D 11 The Grange Howarth 3452

Miss Cuthbert H 34 Sycamore Gardens Hightown 3770

Mr Routledge T 38 Sycamore Gardens Hightown 3801

Mrs Paige E 54 Star Hill Holmfirth 3899

Ms Bennett L 54 Darcy Square Howarth 2871

Mr Rattenbury R H 76 Regent Place Lowtown 2981

Miss Austin E Peak View Arms Castleton 2521

Ms Tate L 11 Uphill Close Lowtown 1325

Mrs Dimmock C R Pinetree Cottage Holmfirth 1781

Mr Dimitri I 17 The Grange Howarth 1146

Mr Black S 7 Simmington Mews Howarth 1468

Mr Guilder D 21 Alderley Way Castleton 6388

Miss Bridge T Brock Hill Farm Lowtown 3447

Mrs Naylor G The White Swan Lowtown 3664

Mrs Deerham B H Oaktree House Howarth 2272

Miss West-Whickham W 1 Market Square Bakewell 1909

Mr Furton P J 15 Denby Court Howarth 1007

Mrs Keegan D 14 Brock Hill Lane Lowtown 2115


